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Reply to email
To reply to a message, you open or select it from the inbox. Click Reply on the 
toolbar to reply to the sender only. You could click Reply All on the toolbar to 
send a reply to all recipients of the original message, as shown below.

The reply window is then displayed with the To and Subject fields complete. The 
cursor is in the message area, ready for you to type in your reply. The original 
message is also displayed in the reply window.

When replying to email messages, you might want to include all or part of the original 
message in your reply. This can help recipients understand which parts of their 
message you are referring to. Depending on your email software, there are different 
ways to format the original message to make it stand out from your new message. 

Replies and forwards
Most people don’t like to receive long email messages. So you should only include 
the original message if it is really necessary. There may also be instances when you 
don’t want to include the original message. This could be because it:
•	 contains sensitive comments
•	 is too long
•	 includes responses from several other writers that are unnecessary. 

If you don’t want to send the original message or you want to indent or attach a 
prefix in your replies, you can set your email accordingly, as in the next example.
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Practice task 1
For the following scenarios, identify and record the type of electronic communication that you 
believe should be used in each situation.
1.	 On a weekend, Claire needs to advise all staff that a meeting to be held at 7.00 am 

Monday morning has been postponed.

2.	 Ron is travelling to a sales expo in a regional town centre. He will need to check his email 
throughout the day. He has to schedule appointments with several clients during the few 
days he will be away.

3.	 Farzin is completing a business course and needs to communicate with other students as 
they finish off a project that is due on Monday.

4.	 Imranha arrives home and realises that she hasn’t replied to an urgent email that was sent 
to her work email address.

5.	 Marco has recently started work in a customer service department. He will need to access 
email from his desktop computer during business hours.

6.	 Here are the subject lines of some email messages Vanessa receives:
•• Hello there!
•• Meeting minutes 8 March
•• Client query about prices
•• You want to know this
•• Canberra flight times
•• Wow! What a result!
•• Report for July sales
•• A quick question
•• Missing client address

Which of the subject lines tell her what the corresponding email is about?



12 Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting

BSBITU203
Communicate electronically

Subject line 
The subject line should contain a brief description or title for your message. This 
is one of the most important parts of an email message. You can send a message 
without filling in the subject line, but this could frustrate the recipient. An email 
sent without a subject line can also appear suspicious and some people may delete 
it as a precaution against virus transmission. 

You have already read about the importance of checking the subject line as a 
recipient. You should also make your own subject line clear and precise. It helps 
your recipient make decisions about the importance of your message and when 
and how to deal with it. A well-written subject line also makes it easier for both the 
sender and receiver to file the message and find it later. 

In the following examples, note that the good subject lines describe the content of 
the email quite clearly.

Poor subject line

•• Information
•• More work completed
•• Sales meeting 
•• Answer

Good subject line

•• Launch of email book
•• Annual report 2015/2016
•• Sales meeting minutes: 10 April 2016
•• Answer to your query of 6 March 2016

Greeting
The type of greeting you use depends on who you are sending your message to 
and its purpose. It also depends on whether you are expected to use a formal or 
informal tone. For example, you may start your email with ‘Dear Mr Harcourt’ 
if Mr Harcourt is an important client you don’t know very well, or simply ‘Dear 
John’ if John is someone you know well. If you are in any doubt, it is always better 
to use a formal greeting. A formal greeting is also better when the recipient may 
need to forward the message to someone else, such as their manager.

You should consider the following questions:
•	 Is the greeting appropriate for the audience? 
•	 Is the greeting appropriate for the purpose of the message? 
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Close
If you have included a greeting, you should also include a close. How you sign off 
(close) your message depends on the purpose of the message and your audience. 
The close should match the formality or informality of the greeting. ‘Yours 
sincerely’ is a more formal close than ‘Regards’. If your email message includes a 
request, ‘Thank you’ might be appropriate. 

Electronic signatures
Your electronic signature should contain your name and any other details your 
organisation wants to include. This may be your job title and contact details. You 
need to provide enough information for the recipient to contact you easily. Your 
organisation may have a set format for electronic signatures so that all staff project 
a consistent company image. 

If your organisation doesn’t have a set format for staff electronic signatures, you 
can set your own. You could also do this for your personal emails at home. 

With a new email open, go to the File tab, then Options. Select Signatures on the 
right-hand side.

You can create a new signature by clicking New. Choose whether the signature is 
displayed for New messages and/or for Replies/forwards.

Write the text for your signature, then click OK.

To insert your signature, go to the Insert tab, click the arrow under Signature and 
choose the signature you would like to use.

You can also edit or remove a signature.
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Some organisations may use different types of spreadsheet programs, or different 
versions of a program. The most commonly used spreadsheet for general items is 
Microsoft Excel. However, there are different versions and data must be saved in 
a version the person receiving your email is running on their system. This also 
applies to Microsoft Word documents and, as new software is written, sometimes 
it is necessary to check the extension on the attachment. For example, documents 
in Microsoft Word versions before 2007 save as ‘filename.doc’ while newer versions 
save as ‘filename.docx’. If a receiver says they are unable to open their attachment, 
check to see if this is an issue and, if necessary, resend the item saved in a different 
version of the software.

If you need to attach a number of files or large files to an email message, consider 
two alternatives.

Divide

└└ Divide the message into a number of smaller messages. For 
example, if you are sending drafts of a large report, send each 
section in a separate message. Make sure you label your 
messages very clearly in the subject line; for example, ‘Sales 
Report Section 1: message 1 of 3’ and ‘Sales Report Section 2: 
message 2 of 3’.

Reduce

└└ Reduce the size of large files by compressing them. You first 
have to check with the receiver that they have the software for 
decompressing them. There are many different applications 
available that compress files; for example, DropStuff(™) and 
WinZip(™). It doesn’t matter what you use, as long as the 
recipient has a program that can expand the files when they 
receive them. 

Tips for email attachments

When you are preparing to send attachments, consider the following issues:
•	 Attachments take up space on the receiver’s system. Some ISPs have a limit on 

the size of attachments they allow, so your attachments might be too large for 
the receiver.

•	 The receiver’s computer may not have the capacity to open large files. 
•	 Large attachments can take a long time to download. 
•	 Portable Document Format (PDF) files are secure and can’t be altered. The 

recipient must have Adobe Reader to open PDF documents. 
•	 Printing costs for documents are transferred to the receiver, which might not 

be appropriate for some business transactions.
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Look at the subject lines and at who the emails are from. After dealing with those 
marked urgent, decide which ones you think are important for your work. Open 
these next and take note of what they require you to do, replying if necessary.

Example: how other people deal with email
A group of people were discussing email at work. These were some of their comments:
Toby: I deal with a lot of customers by email. It takes up to two weeks for the customer to 
receive the product from the time they place the order. I reply to acknowledge the order. If we 
don’t acknowledge the order, the customer goes elsewhere.
Saedee: I find that my response time depends on who the sender is. Messages from the 
director’s office are often marked as urgent, so they usually expect me to respond straight 
away. If it is from a colleague, they are a bit more understanding.
Chloe: I usually respond to emails that need an urgent reply within a couple of hours. I still try 
to respond to all the others, but I can wait until I have more time available.

Send urgent/important email 
Email programs offer a range of tools you can use to alert the receiver that your 
email requires special attention. You might need to send an email to a client about 
an urgent meeting. In this case, you will need to mark the message as urgent. 
You can set a message to be of high, normal or low importance. By default, the 
importance level in most email software packages is set to normal. Using the 
importance feature on the Outlook toolbar, urgent mail messages can be assigned 
a high level of importance. 

You can also insert priority instructions by clicking the File tab and Options. 
Scroll down to Send messages. You can mark a message as either very important 
(click High) or not important (click Low). 

You can also change the sensitivity level of messages. For example, if you need to 
send an email to another staff member about their leave entitlements or salary 
conditions, you can mark the message as private, personal or confidential. This 
also prevents the message from being modified after it has been sent. Such labels 
are applied to a new mail message after it is created through the File tab and 
Options. To mark a message as private, personal or confidential, choose the 
Sensitivity drop-down list under Mail and select the appropriate option. 
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Deal with suspicious or potentially dangerous email

Suspicious or potentially dangerous email messages can contain computer viruses 
or spam. You will learn more about applying security procedures to minimise or 
eliminate the impact of spam and viruses later.

Practice task 3
Claire works at public relations firm Larger Than Life. This table identifies a range of emails 
she has either received or been asked to send as part of her role. Using the table, identify the 
characteristic of the email and suggest actions for Claire to ensure she processes the email 
appropriately. The first email has been done for you.

Email Characteristic Action

An email from a regular 
supplier identifying special 
offers on products that are 
available for that month.

Business related, not 
urgent.

Follow your workplace policy 
regarding purchasing and 
advertisements. This may 
be to forward the email to 
an appropriate person for 
consideration, or to ignore and 
delete the email.

A tender (quote) that is 
being sent to a client 
detailing the costs of a new 
advertising campaign. 

A major client wants the 
managing director to 
contact her urgently.

Claire has received an 
email with the subject line: 
Improve your love life.

Claire must confirm that 
all recipients read the 
email she is sending them 
regarding next month’s WHS 
meeting.

Claire’s friend has sent her 
an email with photos of a 
party they attended last 
week.
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Part B
Complete either questions 1 to 3 about receiving emails at your workplace, or 
questions 4 to 6 about receiving emails at home.

1.	 Over a period of two days at work, complete this table showing details of:
•	 the types of emails you receive at work, such as customer enquiries, 

information for staff, details about your tasks, potentially dangerous emails 
and personal emails

•	 the number you receive of each type
•	 the way you have to respond to each type, such as forward, reply, file, print 

out or delete. 

Types of emails Number of each type How you responded

continued …
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What to do if you suspect your computer has been 
infected
If you suspect your computer has been infected by a virus and you have a virus 
protection program, immediately run a full scan of your computer. In cases where 
you have a virus, the virus protection program will advise you what course of 
action is required. 

If you know the name of the virus, sometimes looking it up on the internet will 
provide you with useful information. As computer viruses become more complex 
and more dangerous, prevention and protection become more important than ever.

You may need to take actions such as:
•	 deleting the infected file
•	 downloading a special file from the internet to remove the virus completely
•	 seeking professional advice
•	 advising your IT department or manager, in line with your workplace policy 

and procedures.

Spam
Spam is unsolicited commercial or junk mail. It is similar to paper-based junk 
mail. You don’t ask for it, it clogs up your inbox and it is usually trying to sell you 
something. Delete junk email as soon as you identify it. Chain emails are also 
regarded as spam. Do not forward chain emails. The more spam people have in 
their inboxes, the less effective email is as a business communication tool. 

Australia has anti-spam legislation. It prohibits sending 
unsolicited spam that has an Australian link. This 
includes spam sent by mobile phone as well as email. The 
law has stiff penalties with fines of up to $1.1 million for 
breaking it. However, some experts believe the law might 
not be able to stop professional spammers from sending 
mass messages. Delete all chain emails and junk emails 
and don’t forward or reply to them.

Individual filtering options
You also have the ability to set your own filters for the emails you receive. 
Depending on the email receipt program you have, you may need to ask for help 
the first time you set these. Make sure you know how to take the settings off again 
for special situations where an email is accidentally prevented from coming to 
your mailbox. Check that you may do this with your supervisor and/or your IT 
department.

For example, in Outlook:
•	 Go to the Home tab and to the Delete tool group.
•	 Select the Junk drop-down menu and then select Junk email options.
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•	 If you choose Attachments, all the emails with attachments will appear at the 
top of your inbox. Attachments use up a lot of memory on your computer. You 
may prefer to print and file them, then delete them from your inbox.

Practice task 6
Read the case study, then complete the task that follows.

Case study

Claire has established several folders to manage her email:
•• Inbox
•• Drafts
•• Sent items
•• Deleted items
•• Planning notes
•• Training and assessment
•• Stock reports and ordering
•• Omega project
•• Personal

In this table, identify the folder she should use to store each of the emails she receives.

Email Folder

Notes for next month’s WHS committee 
meeting

Email sent to sales staff

Invitation to a friend’s birthday party

Stationery prices received from supplier

Conference details for Omega promotion

Assessment task to be completed for her 
business course

Spreadsheet of Omega budget

Confirmation of travel arrangements for 
managing director to Omega conference

Correspondence from her friend
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Email messages can be copied and stored:
•	 in your email program
•	 in other software applications 
•	 on your computer 
•	 on a shared computer network 
•	 on thumb drives, external hard drives, CDs or cloud-based storage
•	 in a filing system in paper-based form. 

Example: email handling
Claire at Larger Than Life has just finished sorting her emails into various folders. Now the 
firm’s IT officer has advised Claire that she has exceeded her mailbox limit. This could be 
because of the size of the various attachments related to the Omega project. Claire has 
decided it is time to review whether she needs to retain all of her emails. Here are the actions 
she has decided to take with a selection of her emails.

Email Action

Notes for next month’s WHS Committee 
meeting

Store hard copy in WHS Committee folder. 
The agenda has already been prepared.

Email sent to sales staff Save

Invitation to a friend’s birthday party Delete

Stationery prices received from supplier Print and store a hard copy in the stationery 
folder.

Conference details for Omega promotion Save in email and save backup copy onto a 
thumb drive.

Assessment task to be completed for her 
business course

Complete assessment task and delete 
email.

Spreadsheet of Omega budget Save in email program and on a backup 
thumb drive.

Confirmation of travel arrangements for 
managing director to Omega conference

Print for Robert and then store electronically. 
Save additional copy on a backup thumb 
drive.

Correspondence from her friend Delete
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Delete email 
When you are absolutely sure you no longer need an email message, delete it. Some 
email systems have a Delete button, so all you have to do is select the message 
and click on the button. The message will then be removed from your inbox or 
whatever folder it was in. However, the message may not be permanently deleted. It 
might just have been moved to a Deleted Items folder, as in the following example.

Permanent deletion

If you want to permanently delete the message, you will need to delete it a second 
time. Select it in the Deleted Items folder and click Delete again. You will then get 
a warning: ‘This will be permanently deleted. Continue?’

Remove all files from your Deleted Items folder regularly.
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Address book
The Address Book in Microsoft Outlook stores names, email addresses and fax 
numbers to which you can send mail messages. The Address Book can contain 
many different address books, such as the following:
•	 Global Address List – This contains all email addresses for users and work 

groups within your organisation. Only the system administrator can add new 
users to this list. 

•	 Contacts – This is used to customise and store the email addresses of the 
business contacts you use. 

To create a new contact group, select the Home tab, then in the New group, select 
the New item drop-down menu. Select More items, then Contact group. Enter 
the contact details. You can do this for your personal mail if you are not at work.

Alternatively, find out how to set up a contact group in your workplace’s email 
system. Check your procedures manual or ask a colleague or your supervisor to 
help you.

Maintain electronic mailing lists 
For email to be an effective way of sending business correspondence, addresses 
must be maintained. Make sure you maintain the currency of your lists by always 
checking whether an address or name has changed and adjusting your records 
accordingly. 

Maintaining address lists is a very important part of communicating successfully 
by email. As discussed in Topic 1, incorrect addresses result in undeliverable mail 
with possible serious consequences for you and your organisation. 

When preparing email addresses and contact groups, there are three key points to 
remember.

Correct spelling

└└ Ask people to spell out their email addresses slowly, and repeat 
the addresses back to them to ensure you have heard them 
correctly. Some email addresses have numbers and others have 
symbols in them, such as hyphens (-) or underscores (_). 

Consistent entry

└└ Enter the email addresses into your organisation’s email system 
in a consistent way, so that the system will sort the addresses 
in an easy-to-find order. For example, enter a first and last name 
for everyone, or only a first name for everyone. Don’t use a mix of 
both, as this could result in some addresses being sorted by first 
name and some by last name. 

continued …
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Online collaboration tools provide ways to communicate in real time with other 
parties by typing, by voice, by video or by all three methods. A range of tools is 
available including chatrooms, file transfers and application sharing. Usually, all 
participants must have compatible software installed and may need a headset, a 
microphone and/or a video camera.

In this section you will learn about some of the more widely used online 
collaboration tools, including:
•	 instant messaging programs
•	 Voice over Internet Protocol (VoIP)
•	 web-based meeting programs.

Instant messaging
An instant messaging program is one that can instantly send messages from one 
computer to another. They are a form of ‘instant email’. They can let you know 
when your friends or family are online and allow you to send them short messages, 
similar to sending an SMS text message on your mobile phone. Instant messaging 
applications let two or more people ‘talk’ in real time by typing messages in a chat 
window, using a headset to carry on a conversation, or using a video camera and 
microphone to both talk and see other people.

Some common instant messaging applications

•• Apple iMessage
•• Facebook
•• Jabber
•• Skype
•• Trillian
•• Twitter
•• Yahoo Messenger

Messaging benefits

Most instant messaging programs are free and are either installed with new 
computers or can be downloaded from the internet. Some instant messaging 
programs have versions that work on mobile telephones or tablets. Once the 
program is running on your computer, you will need to create an account and a 
profile. Your user profile may include personal information.

Most instant messaging applications include the ability to set up a conference 
room for multiple people. However, there may be restrictions because you cannot 
have a chat with contacts using two different instant messaging applications.

3A	 Identify software used to collaborate



72 Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting

BSBITU203
Communicate electronically

The main features of online forums include:
•	 the ability to categorise messages
•	 a mechanism for creating responses to the original messages (often called 

threading)
•	 the capacity for all participants to view all of the messages and responses in 

the forum
•	 a mechanism for finding old threads.

Using online forums

Groups that use online forums appoint a moderator for each discussion. The role 
of the moderator is to edit, move or remove comments as required. The moderator 
is responsible for deciding how long postings remain on the discussion board. 
They are also responsible for cautioning users who do not comply with the rules or 
guidelines for use of the online forum. Postings stay on the discussion board for as 
long as the moderator wants. 

It is important to remember that forums require the member to visit the website 
and check for new posts. You should check the forum regularly. You may be able to 
arrange for an alert email to be sent when there are any new postings that relate to 
the thread you have been participating in. 

Guidelines for using an online forum

There are typically two options for posting a message: you can reply to 
someone else’s message or you can start a new topic of discussion.

You can reply to or comment on a post by clicking on the Reply button. This 
reply will usually appear below the message that you are replying to.

To start a new topic of conversation, click on New Topic. When people 
comment on your contribution, the comments will be displayed under the 
topic name you created.

Discussions are often viewed in threads. Each discussion may have several 
threads made up of an initial post and replies to that post.

Intranet versus internet discussions
The internet is the ‘web’ of computers spread throughout the world, while an 
intranet is an internal site that operates on your company’s own servers. It is a 
‘web’ of computers spread across your own business world. 
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In some cases you might want to simply allow other people, including team 
members, to view files. In other instances, you might want to allow your work 
colleagues to edit your files and then upload them. Information-sharing tools 
such as ‘wikis’, Google Drive and Microsoft’s SharePoint include a version control 
system that prevents people from undoing each other’s work and also allows you to 
track changes to show exactly who did what (and when).

Wikis
Wikis are collaborative websites that allow users to add and edit content. The word 
‘wiki’ is Hawaiian for ‘fast or quick’ and can refer to the site or software installed 
on the site.

The prime example of a wiki is Wikipedia, the open-source encyclopaedia. Almost 
all wikis use revision control to prevent abuse and track changes, so if someone 
decides to erase one or more pages it is easy to ‘revert’ back to the previous good 
version. If someone repeatedly attempts to abuse the system, their IP address can 
be blocked.

Installation of a wiki requires that you upload or copy files to your server, create 
an SQL (structured query language) database and user account, and run the 
installation scripts. Installation packages are available for some wikis.

The benefits of using a wiki

•• It records ideas quickly, giving you more time for formal 
writing and editing. 

•• It’s instantly collaborative without emailing documents. 
•• It’s accessible from any computer with access to the internet. 
•• It enables archiving of revised pages. 
•• It promotes participation in innovation and change through 

the sharing of ideas. 
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… continued

Flames

└└ Don’t send aggressive messages, even if you are justifiably angry 
about something. Such messages are called ‘flames’. If you have 
to send a stern or difficult message of some kind, wait until you 
are calm or even think about it overnight before you send it.

Thanks

└└ If you have asked for information from someone, thank them 
when you receive it. Always use the same polite behaviour as you 
would if you were face-to-face with someone.

Criticism

└└ Be careful about criticising other people in emails. This is not 
ethical and, moreover, you cannot assume that you and the 
addressee will be the only people to read your email. Email is not 
necessarily private.

In some cases, organisations have developed policies and procedures that relate 
specifically to the use of either email or other forms of electronic communication. 
The following example is an extract from Larger Than Life’s email usage policy.

Example: email usage policy

Larger Than Life Email Usage Policy
•• Allow time for mail to be received, and replied to, keeping in mind time differences around 

the world and other colleagues’ busy schedules.
•• Do not send abusive or heated messages (flames). If you receive a flame, it is best to ignore it.
•• Don’t assume any internet communication is completely secure. Remember, never put in 

an email message anything you would not put on a postcard.
•• If you are forwarding or re-sending a message, don’t change the original wording.
•• If you are replying to a message, quote only the relevant parts.
•• If you want your mail to be read, don’t make it too long. An email of more than 100 lines is 

considered too long.
•• Mail should have a subject header that reflects the content of the message.
•• Never send chain emails. You should notify the system administrator if you receive one.
•• Remember the internet is a global community, and other people’s values and outlook on 

life may be different to your own. Be tolerant and careful with slang or phrases that may 
not be understood broadly.

•• Take care with addressing email.
•• Unsolicited email advertising is unwelcome (and forbidden in many countries).
•• Use mixed case, UPPER CASE LOOKS AS IF YOU’RE SHOUTING.
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Protocols to guide users in the use of online communication platforms have been 
developed by most organisations. In this section, you will examine the protocols 
and procedures that you should follow to respond to posts or communications.

Participate in online meetings
As a participant in an online meeting, you may be asked for your views on issues, 
to provide an update of your progress on specific tasks or to participate in a 
general discussion about a particular work topic. You are able to contribute to the 
meeting at any time. You will also be able to read all the views of others and make 
comments as well. You do not need to wait to be called on unless that is specified 
by the chair. Post comments until the chair puts up a message that it is time to 
move on. Remember that comments appear in the order they are posted in, so 
conversations will not be grouped together. 

You should bear in mind that it is easy to be misinterpreted in this environment 
because of the absence of visual cues such as gestures and facial expressions, so 
avoid jokes and sarcastic comments.

Bulletin boards 
Bulletin boards and discussion lists are ways of distributing email messages 
to groups of people who subscribe to the lists. Each list has its own set of rules 
and guidelines, which are set up to stop people from sending inappropriate 
information. If you are sending messages to a bulletin board or discussion list, 
make sure you understand the rules of the list and have the correct address and 
relevant information that the list’s subscribers would like to know. 

Remember that you are representing your workplace. Have your message 
authorised by your manager first to make sure that the views you are expressing 
are those of your employer. 

Many people make embarrassing mistakes when sending email to bulletin boards 
and discussion lists. 

Common bulletin board mistakes

•• Using an incorrect address or hitting the reply all button and 
sending an email to the whole list when you only meant to 
send it to one person

•• Sending irrelevant information that wastes everyone’s time 
•• Misrepresenting your organisation 
•• Including part of another person’s message in your message 

to the group, without the other person’s permission

3C	 Respond to online posts 
or communications
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This learning checkpoint allows you to review your skills and knowledge in 
collaborating online.

Part A
Read the scenario, then prepare an email about it to be distributed to staff.

Scenario

Your supervisor has asked you to help her coordinate next month’s sales meeting. Her 
plan is to conduct the meeting with interstate sales staff online. She knows you have 
been learning about electronic communication in your studies. Your supervisor would 
like you to draft an email or memo that she could send to participants that covers the 
following:

•• The advantages of conducting meetings online
•• How online meetings are conducted
•• The netiquette required for online meetings
•• Any tips that would assist participants to contribute most effectively to the meeting.

Remember to prepare a suitable subject line for your memo or email.

You will need to refer to your workplace policies and procedures when drafting 
your memo or email. If you do not have access to these documents in a workplace, 
you may wish to refer to the various policies and procedures for Larger Than Life 
that you will find throughout this learner guide.

Learning checkpoint 3 
Collaborate online


